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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such 
products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be 
liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 
12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for 
Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notices

© Copyright 1997-2011 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

Intel®, Intel® Itanium®, Intel® Xeon®, and Pentium® are trademarks of Intel Corporation in the U.S. and other 
countries.

Java™ is a U.S. trademark of Sun Microsystems, Inc.

Microsoft®, Windows®, Windows® XP, and Windows Vista® are U.S. registered trademarks of Microsoft 
Corporation.

Oracle® is a registered trademark of Oracle Corporation and/or its affiliates.

UNIX® is a registered trademark of The Open Group.
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Documentation Updates

This manual’s title page contains the following identifying information:

 Software version number, which indicates the software version

 Document release date, which changes each time the document is updated

 Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

h20230.www2.hp.com/selfsolve/manuals

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact 
your HP sales representative for details.

Why version number 9.10?

PPM Center is an integrated part of the HP BTO Operations version 9 portfolio. Using this version number aligns 
PPM Center with other products that are releasing in the same time frame. PPM Center 9.10 builds on  
PPM Center 8.0x and is an extension of that product version family. Product releases within the HP BTO Operations 
version 9 portfolio will feature shared technology, common platforms, integrations, solutions, upgrade tools, and 
professional services offerings.

3



Support

You can visit the HP Software Support Web site at:

hp.com/go/hpsoftwaresupport

HP Software Support Online provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

 Search for knowledge documents of interest

 Submit and track support cases and enhancement requests

 Download software patches

 Manage support contracts

 Look up HP support contacts

 Review information about available services

 Enter into discussions with other software customers

 Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to: 

h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to: 

h20229.www2.hp.com/passport-registration.html
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1 Introduction
Operational Reporting for HP Project and Portfolio Management Center (PPM 
Center) enables you to provide rich, interactive reports on PPM Center data. 
You can use it to distribute weekly reports, provide customers with 
personalized service offerings, or to integrate business-critical information into 
corporate portals.

This document provides details about how to use BusinessObjects’ web 
desktop tool InfoView to generate operational reports on HP Resource 
Management, HP Time Management, and HP Financial Management data. The 
following chapters include descriptions of the preconfigured operational 
reports that HP supplies with the solution and instructions on how to run them, 
covers some of the ad hoc reports that you can create for PPM Center data, and 
provides detailed examples of how to create the Web Intelligence documents 
and construct queries for ad hoc reports.

Audience for this Document

This document is written for PPM Center users, particularly users who act as 
direct managers, resource managers, and project managers. Readers are 
assumed to be familiar with the functionality of all PPM Center products and 
with SAP BusinessObjects.

New development of PPM Center reports will continue to expand on this new 
Operational Reporting platform.
9



Related Documents

This section lists the HP documents that contain useful information for 
Operational Reporting users. For information about how to obtain the HP 
documents listed, see Accessing Documentation.

The following documents provide useful information for Operational 
Reporting users:

 HP Financial Management User’s Guide

 HP Resource Management User’s Guide

 HP Time Management User’s Guide

 HP-Supplied Entities Guide (includes descriptions of all portlets, request 
types, and workflows in PPM Center)

 Data Model Guide (provides details about the internal structure of the data 
models for both PPM Center and Operational Reporting)

Accessing Documentation

To obtain any of the HP PPM Center documents listed, go to the Software 
Product Manuals Web site (support.openview.hp.com/selfsolve/manuals). To 
access this Web site, you must first set up an HP Passport account.

For information about SAP BusinessObjects Enterprise, see your SAP 
documentation. For information about how to access SAP documentation, see 
the HP knowledge document “Documentation for Customers using the 
Operational Reporting Solution (Business Objects) with PPM 9.1x” 
(support.openview.hp.com/selfsolve/document/KM1052487).
10 Chapter 1
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HP-Supplied Reports

HP provides the following preconfigured module-specific reports with the 
Operational Reporting for HP Project and Portfolio Management Center (PPM 
Center):

 Demand Vs Capacity report, for reporting on HP Resource Management

 Time Sheet Compliance report, for reporting on HP Time Management

 Financial Summary report, for reporting on HP Financial Management

You can use these HP-supplied reports to quickly run a report query that 
generates clear data that are easy to interpret, even if you have limited 
knowledge of BusinessObjects and InfoView. Each of these preconfigured 
reports is a Web Intelligence document that you can view and work with using 
BusinessObjects’ Web desktop InfoView.

Each of the HP-supplied reports has an associated set of prompts that you can 
use as configured or modify to filter your data differently. These reports are 
designed for typical use-case scenarios and are described fully in later 
chapters.
Introduction 11
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2 Reporting on HP Resource Management
This chapter addresses Operational Reporting for HP Resource Management. 
It provides information about the preconfigured Demand Vs Capacity report, 
which HP supplies, and some of the many the ad hoc reports that you can 
create for your HP Resource Management data.

Demand Vs Capacity Report

The Demand Vs Capacity Report that HP supplies with Operational Reporting 
is designed to help you review and proactively manage demand to optimize 
resource use within your organization. This report enables you to view PPM 
Center resource capacity (from resource pools, both named and unnamed), 
demand (from staffing profiles broken down by committed, soft-booked, and 
unmet demand), and the actual effort coming from time sheets. You can use 
the Demand Vs Capacity report to compare demand against capacity for 
different roles by grouping the data by region, resource pool level, or role.

The actual effort shown in the Demand Vs Capacity report reflect all of the 
time that resources have logged in time sheets, except for time logged on time 

Because capacity is not assigned for a staffing profile or a position, resource capacity 
is captured within the context of a resource pool, and not in the context of staffing 
profile. Capacity for a resource is assigned by a resource pool manager who may not 
know how (to what position) a resource is to be allocated.
13



sheets that have been cancelled. If time logged against a task is rejected, that 
actual effort is excluded from the report.

Grouping Report Data

You can group demand, capacity, and effort information presented in the 
report based on region, resource pool, or role. Based on the grouping parameter 
you select (you select only one grouping parameter at a time), the report 
displays an aggregate total for each group.

Table 2-1 provides information about how the Demand Vs Capacity report 
displays data based on the grouping you select.

PPM Center’s TM-PM Sync Service rolls up time sheet actuals to projects. Depending 
on how often this service is scheduled to run on your PPM Center system, the actual 
effort displayed in the Demand Vs Capacity report may not exactly match the staffing 
profile actuals.

Table 2-1. Data display in the Demand Vs Capacity report based on grouping

Selected 
Grouping Data Displayed

Role

Capacity is displayed at the role level as total. Demand is 
displayed at the role level per staffing profile and total for each 
role level.

If a resource is assigned to a position to meet the demand, then 
one of the following is true:

 The resource role (associated with the corresponding 
capacity) is the same as the role of the position to which this 
resource is assigned. In other words, the capacity role is the 
same as the demand role.

 The resource role (associated with the corresponding 
capacity) is different from the role of the position to which this 
resource is assigned. That is, capacity role is not the same as 
the demand role.

In either case, the Demand Vs Capacity report shows capacity 
as a function of the resource’s role, and shows demand as a 
function of the position’s role.

Resource Pool
Both capacity and demand are displayed at the role level for 
each resource pool. You can view capacity from both named and 
unnamed resource pools.
14 Chapter 2



How Regional Calendar Affects Demand Vs Capacity Report Data

Table 2-2 shows which calendars are used to calculate resource capacity for 
the Demand Vs Capacity report.

Region

Both capacity and demand are displayed at the role level for 
each region.

Resource pool capacity is accounted against the resource pool 
region and demand is accounted against the staffing profile 
position’s resource pool region for both unmet and met demand. 
One exception to this is that, if there is unmet demand that is not 
associated with a resource pool, then the report accounts for the 
unmet demand against the staffing profile region.

Note: In an ad hoc Demand Vs Capacity report that includes the 
query “show the demand for positions in a staffing profile,” all 
demand is accounted against the staffing profile region if you 
select the Demand from Staffing Profile Region context. For an 
ad hoc Demand Vs Capacity report that includes the query 
“show the capacity of resources in a resource pool,” all of the 
capacity is accounted against the resource pool region.

Table 2-1. Data display in the Demand Vs Capacity report based on grouping

Selected 
Grouping Data Displayed

Table 2-2. Calendars used to calculate capacity (in hours, person days, and 
FTEs) for PPM Center resources

Resource Calendar Used to Calculate Capacity
(Hours or Days)

Named Resource

Hours and days and FTE are calculated based on the 
resource's regional calendar and the resource's 
exceptions.

are calculated based on the calendar on the 
Resource detail page, which is derived from the 
regional calendar associated with the resource.

FTE is calculated based on the calendar that is 
associated with the resource’s region.

Unnamed Resource
Regional calendar associated with the resource pool, 
which is based on the resource pool region.
Reporting on HP Resource Management 15



Table 2-3 shows which calendars are used to calculate demand data presented 
in the Demand Vs Capacity report.

Running the Demand Vs Capacity Report

To run the Demand Vs Capacity Report, do the following:

1. Open a web browser window and log on to InfoView.

2. In the Navigate section or in the header panel of the InfoView home page, 
click Document List.

3. In the Tree panel in the left portion of the page, expand the Public Folders 
folder, and then select HP Reporting > Resource Management Reports.

The Details panel to the right of the Tree panel lists the available report 
documents.

4. Double-click the row that displays the Demand Vs Capacity Report 
document.

The Prompts dialog box lists the prompts that are available for the report 
query. All prompts for which values are required have default values, but 

Table 2-3. Calendars used to calculate demand (in hours, person days, and 
FTEs) for PPM Center resources

Demand Calendar Used to Calculate Demand
(Hours or Days)

Met Demand

(Committed / soft-booked)
Regional calendar associated with the resource pool.

Unmet Demand

 For unmet demand associated with a resource 
pool, regional calendar associated with the 
resource pool (based on the resource pool region).

 For unmet demand not associated with a resource 
pool, the regional calendar associated with the 
staffing profile.

The folders and objects visible in the document list vary, depending on the 
account you logged on to, the rights that your BusinessObjects Enterprise 
administrator granted to you, and the settings that you and your administrator 
enable.
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you can change these values, and specify values for any or all of the 
optional prompts listed.

5. To filter the data further, before you run the report, provide information for 
the prompts listed and described in the following table.

A green check mark ( ) to the left of a listed prompt indicates that the prompt is 
required, and that a value has been specified for it. A red arrow ( ) to the left of 
a listed prompt indicates that the prompt is required and you must specify a value 
for it before you can run the report query.

If you do not specify a value for a prompt, the filter is not applied to report data.

Prompt
* Value Required Description

*Primary Grouping

Determines how data are categorized in the 
report. Select one of the following values:

 Region

 Resource Pool

 Role

*Begin Period
Determines the first time period for which data 
are displayed in the report. Select a value from 
the Available Periods list.

*End Period
Determines the last time period for which data 
are displayed in the report. Select a value from 
the Available Periods list.
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*Time Granularity

Determines the time interval for data displayed 
in the report. Select one of the following 
values:

 Year displays time periods as yyyy

 Half Year displays time periods as 
h1 or h2/yyyy

 Quarter displays time periods as quarter/
yyyy

 Month displays time periods as mm/yyyy

 Week displays time periods as 
mm/dd/yyyy

Note: If you specify a long report period and 
Week as the time granularity, and you export 
the generated report data to Microsoft Excel, 
the data in the resulting Excel file may be 
truncated as a result of formatting limitations. 
You can only work around this by exporting the 
Web intelligence document to a text file, and 
then opening that file in Excel. File formatting 
is lost in this case.

*Time Unit

Determines the time unit (FTE, person days, or 
hours) to use to display capacity and demand 
data in the report. Select one of the following 
values:

 FTE

 Person Days

 Hours

Resource Pool

Determines which resource pools are 
represented in the report. From the Resource 
Pool Name list, select one or more resource 
pools names.

Prompt
* Value Required Description
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6. From the list in the top section of the dialog box, select a prompt.

7. InfoView lists available values for some prompts in the box in the lower 
left portion of the dialog box. If no values are listed for the prompt you 
select, click Refresh Values to display the values.

8. After you finish specifying optional data filters, click Run Query.

Web Intelligence retrieves the data for the default values and returns the results 
to the reports.

Region
Determines the region for which data are 
displayed in the report. Select a value from the 
Region list.

Role
Determines the roles represented in the report. 
Select one or more values from the Role 
Name list.

Resource Category

InfoView lists all of the resource categories 
defined for resources in PPM Center.

From the Resource Category list, select one 
or more resource categories to include in the 
report.

Prompt
* Value Required Description
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Demand Vs Capacity Report Results

Table 2-4 provides descriptions of the columns displayed in the Demand Vs 
Capacity Report.

Table 2-4. Columns displayed in the Demand Vs Capacity Report

Column Description

Grouping category
Reflects the grouping category selected for the report. (See 
*Primary Grouping on page 17.)

Time Unit
Displays the unit (hours, person days, FTEs) used to 
express capacity, demand, and effort in the report.

Resource Pool
Displays the names of the resource pools represented by 
the report data and a No Resource Pool row for demand 
that is not assigned to any resource pool.

Role

Displays the role(s) within each resource pool for which 
report data are displayed. If no filter has been specified for 
the Role prompt, this column lists all roles for each 
resource pool.

Time period

Column headings that show the time period for the report 
data are displayed from left to right, starting with the first 
report period and ending with the report finish period. Time 
period is formatted based on the value selected for the 
*Time Granularity prompt.

Demand

Displays a breakdown of demand for the time period under 
the following column subheadings (expressed in the 
selected for the *Time Unit prompt) for each role in each 
resource pool represented in the report (and for demand 
unassigned to any resource pool:

 Committed - Displays demand for which resource pool 
resources are committed.

 Soft Booked - Displays demand for which resource pool 
resources are soft-booked.

 Unmet - Displays unmet demand.

 Total Demand - Displays

Total demand for each of these columns is displayed for 
each resource pool, as well as for the demand that is not 
assigned to any resource pool.
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Capacity

For each time period, displays a breakdown of capacity 
(expressed in the units selected for the *Time Unit prompt) 
by role/resource pool for the following categories:

 Named - Displays capacity for named resources.

 Unnamed - Displays capacity for unnamed resources.

 Total Capacity - Displays total capacity for named and 
unnamed resources.

Demand Vs Capacity

For each time period, this column displays the discrepancy, 
if any, between total demand and total capacity for each 
role/resource pool. If demand exceeds capacity, the value 
is displayed in red text in parentheses. If capacity equals or 
exceeds demand, the value is displayed in black text.

Actual Effort
For each time period, displays a breakdown of actual effort 
(expressed in the units selected for the *Time Unit prompt) 
by role/resource pool.

Table 2-4. Columns displayed in the Demand Vs Capacity Report

Column Description
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Ad Hoc Reports for HP Resource Management

This section provides information about the operational reports that you can 
create for HP Resource Management, and includes examples on how to create 
a few of these reports. It provides information about the contexts available for 
the reports, recommendations on creating the ad hoc reports, and includes 
guidance on how to use PPM Center universe objects in operational report 
queries.

Contexts for Ad Hoc Reports for HP Resource Management

When you create an ad hoc report for HP Resource Management, InfoView 
may prompt you to select a context for your report query. A context consists of 
a set of well-defined joins that create a unique query path involving multiple 
dimensions and facts. 

If the multiple facts and measures in a reporting universe are related to a 
common set of dimensions, the joins between multiple facts and the related 
dimensions result in a loop. By providing separate contexts for each fact and 
the related dimensions, the loop is eliminated, so that you can query multiple 
facts across a set of common dimensions.

Operational Reporting provides the following contexts for the ad hoc reports 
you create for HP Resource Management data:

 Resource Capacity

Use the “Resource Capacity” context to retrieve capacity information 
across Resource, Resource pool, Roles, Org Unit over a fiscal time period. 
In this context, Region refers to the Resource Pool’s region, Role refers to 
the resource’s primary role and Organization Unit refers to the resource 
pool’s organization unit

 Resource Demand on Resource Pool Region

Use the “Resource Demand on Resource Pool Region” context to view 
resource demand (as in the preconfigured Demand Vs Capacity report) 
based on region. Demand assigned to a resource pool is treated as a 
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demand on the resource pool's region. Demand that is not associated with a 
resource pool is treated as coming from the staffing profile’s region.

In this context, Region refers to the resource pool’s region, Role refers to 
the position’s role, and Organization Unit refers to the staffing profile’s 
Organization Unit.

 Resource Demand from Staffing Pool Region

Use the “Resource Demand from Staffing Pool Region” context to retrieve 
resource demand data across positions, staffing profiles, resource pools, 
regions, and fiscal periods and to see which region (associated with the 
staffing profile) is the source of the demand.

In this context, Region refers to the region associated with a staffing 
profile, Role refers to the role assigned to a position, and Organization Unit 
refers to the organization unit staffing profile belongs to.

 Resource Effort

Use the “Resource Effort” context to retrieve effort data across various 
dimensions (for example, Roles, Resource Pools, Staffing Profiles, 
Regions, and so on.)

In this context, Region refers to the resource’s region, Role refers to the 
task’s role (if the task has a role) or the resource’s primary role, and 
Organization Unit refers to the primary organization unit to which the 
resource is assigned.

 Resource Pool in a region and its Org Unit

Use the “Resource Pool in a region and its Org Unit” context to retrieve the 
resource pools in a region and the org units to which resource pools belong.
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Best Practices for Reporting on HP Resource Management Data

This section provides recommendations for getting the best results in the ad 
hoc operational reports you create for your HP Resource Management data.

Grouping Program Measures by Business Objective for Programs with 
Multiple Business Objectives

Suppose you want to construct an ad hoc report query that includes program 
measures (Forecast, Actuals, Approved, and so on) grouped by business 
objective, and you want the query results to include one or more objects from 
the Business Objectives class (in the FM Derived Universe). If you are 
reporting on a program that has multiple business objectives, the resulting data 
for the measures are multiplied by the number of associated business 
objectives. This produces incorrect report data.

To work around this issue, create a report variable that counts the number of 
separate business objectives for the program. Use this variable in each ad hoc 
report cell that displays the program measure, to divide the cell’s total by this 
value. (The Financial Summary report uses this mechanism.)

Querying Resource Pool Measures When with Resource Pool Have Multiple Managers

Suppose you create a query that includes measures such as Capacity or 
Demand against the Resource Pool dimension, and your query results include 
the Resource Pool Manager object. If you are reporting on a resource pool that 
has multiple managers, the resulting data for the measures are multiplied by the 
number of resource pool managers. This produces incorrect report data.

To work around this issue, create two separate report queries. Design one 
query to retrieve the information about the resource pool dimension or any 
other dimension objects as necessary, without including any measures. Design 
a second query to retrieve the measures.

Effects of Modified Calendar Setup on Data Calculation

If you modify the calendar setup, Actual Effort data displayed in FTEs and the 
Person Days data within the affected time range are not automatically 
recalculated unless modifications are also made to the relevant timesheets.
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Querying Projects with More than One Manager

In querying a project based on project manager, exercise caution when creating 
the filter condition for the query. If the project has multiple managers assigned 
to it, make sure that the query returns all projects managed based on the 
resource name specified in the filter, whether the resource is the only manager 
assigned to the project or one of several managers assigned. When you create a 
query filter for the Project Manager object, select the “Matches pattern” 
operation and add the percent character (%) at the beginning and at the end of 
the name selected from the list of project managers.

 Displaying Demand, Capacity, and Effort Data in FTEs

Demand, Capacity, Effort cannot be calculated in full time equivalents (FTE) 
if a given period the system calendar setup indicates that the total number of 
working days for the period is zero. For example, if every day in a given week 
is configured as a non-working day for a shut-down period, then the demand, 
capacity, and effort data for that week is displayed as zero FTEs. However, the 
value in hours may not be zero. That would be the case if, for example, a 
resource worked during the shut-down period. Even if the calendar indicates 
that the number of working days is zero, the capacity or effort may not be.

To avoid inaccuracies, if the report results show zero FTEs for demand, 
capacity, or effort data, check the values for the same measures in hours. A 
non-zero value indicates the problem lies in the calendar setup, in which case, 
the data returned in hours is more reliable unit for display. (The preconfigured 
Demand Vs Capacity report uses this mechanism to determine whether to 
display demand, capacity, and effort data in FTEs, or as “--” when the total 
number of working days in a period is calculated to be zero.)

Reporting on Resources if the Resource-Manager Hierarchy has No Top-Level Manager

In the PPM Center database, if a resource-manager hierarchy exists, but no 
top-level manager has been assigned to the hierarchy, then a loop exists. The 
results for any reports designed to include resources data excludes all of the 
resources. To prevent this from occurring, make sure that a top-level manager 
is assigned to the resource-manager hierarchy.
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Querying Against Large Datasets

By default, queries time out after running for ten minutes. If you have selected 
query filters that retrieve a large volume of data, your query may time out and 
fail to return report results. To prevent this from occurring, do one or both of 
the following:

 Modify the universe parameters (on the Controls tab of the Universe 
Parameters dialog box) to increase the execution time limit.

 Modify the query filters to retrieve a smaller dataset.

Calculating Resource Over-Allocation

In reporting on over-allocation of a resource, make sure that you include the 
Staffing Profile Name object in the query result, and not just the Project Name 
object. This is especially important if a resource is assigned to multiple staffing 
profiles (some of which may be free-standing) or if org unit staffing profiles 
and not related to the project. If you add only the Project Name object without 
including the Staffing Profile Name object, the results exclude the assignment 
to the resource for non-project staffing profiles, and may not accurately reflect 
over-allocation.

Comparing the Role of a Position and the Role of a Resource Assigned to the Position

In creating a query that compares the role of a position with the actual role of a 
resource assigned to that position, you must do the following:

 Select the Role Name object (Roles class) for the role of the position

 Select the Primary Role object (Resource class) for the role of the resource

 Select either the Resource Demand from Staffing Pool Region or Resource 
Demand on Resource Pool Region context.
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Creating Ad Hoc Reports for HP Resource Management

The RM Derived Universe delivered with PPM Center includes classes and 
objects that enable you to create your own operational reports for HP Resource 
Management data. The following are just some of the ad hoc reports that you 
can create for your HP Resource Management data:

 Resources Assigned to Projects

 All Resources in a Resource Pool

 Baseline Demand Vs. Active Staffing Profile Demand for a Project

 Demand, Capacity, and Actual Effort Report (Grouped by Primary 
Organizational Unit)

 Total Demand Vs. Capacity Plus Additional Resource Pool Data

 Resource Pools by Region

 All Resources by Resource Category

 All Assignments to Resource (by Staffing Profile) with Role, Showing All 
Effort

 Staffing Profile Details for Resources

This section includes instructions on how to create one such report and 
provides descriptions of other ad hoc reports that you can create for HP 
Resource Management.
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Creating an Ad Hoc Report on HP Resource Management Data: Example

A resource pool manager who needs to determine how the resources in various 
resource pools are distributed across projects can quickly create a report that 
provides this information. Table 2-5 shows which RM Universe objects are 
required to create this report, and where they belong in the New Web 
Intelligence Document page.

The following example includes very basic steps required to create and run this 
report query.

Table 2-5. RM Universe objects to include in a report on the resources in PPM 
Center resource pools

Object Class Result Objects Query Filters / 
Prompt Selection Mode

Project Information Project Name Project Name / Prompt

Resources Resource Name

Resource Pools
Resource Pool Name

Resource Pool Managers

Roles Role Name
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Resources Assigned to Projects

To create a report that shows the resource pools and resources assigned to 
projects:

1. Open a web browser window and log on to InfoView.

2. In the Navigate section of the InfoView home page, click Document List.

3. From the New list, select Web Intelligence Document.

4. From the list of available universes, select the RM Derived Universe.

The Data tab in the left pane lists all of the available classes and objects in 
the RM Derived Universe.

5. Expand the Project Information class folder.

The folders and objects visible in the Document List depend on the account you 
logged on to, the rights that your BusinessObjects Enterprise administrator 
granted to you, and the settings that you and your administrator enable.
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6. Drag the Project Name object to the Result Objects section on the right 
(top), and then drag the Project Name object to the Query Filters section on 
the right (bottom).

7. In the Query Filters panel, click the list button ( ) at the right end of the 
Project Name box, and then select Prompt.
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8. In the Query Filters panel, click the Prompt Properties button ( ).

9. In the Prompt Properties section, select the Select only from list and 
Optional prompt check boxes.

10. Click OK.

11. Expand the Resource Pools class folder, and then drag the Resource Pool 

Name and Resource Pool Managers objects to the Result Objects section.

12. Expand the Resources class folder, and then drag the Resource Name 
object to the Result Objects section.
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13. Expand the Roles class folder, and then drag the Role Name object to the 
Result Objects section.

14. Click Run Query.

The Query Contexts dialog box opens.

15. If, as in this case, the set of objects you select to construct your ad hoc 
report query can be retrieved through multiple join paths, InfoView 
prompts you to select a context for the query. (A context defines a join 
path.) Select one of the listed contexts for the report, and then click OK.

To see how a context in the list affects report results, click the context name and 
read the content displayed in the Description box.
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The Prompts dialog box opens.

16. Specify the projects to include in the report, and then click Run Query.

InfoView runs the report, which lists the resources and the resource pools 
assigned to the project.

17. Provide a title for the report.

18. Name and save the document.

All Resources in a Resource Pool

You can create a simple report that lists all of the resources assigned to a 
resource pool.

:

A resource assigned to a resource pool is only included in this report if the 
following are true:

 The resource has capacity data. When you run the query for this report, you 
must select a context to use with the query. Apply the “Resource capacity” 
context to the report query.

 The start date for the resource (Resources Start Date) and (or) the end date 
for the resource (Resources End Date) falls between the start and end dates 
of the HP Resource Management data loaded into the reporting schema.

Table 2-6. RM Universe objects to include in a report that lists all resources in a 
resource pool

Object Class Result Objects Query Filters / 
Prompt Selection Mode

Resources Resource Name

Resource Pools Resource Pool Name Resource Pool Name

Within the resource capacity query context, the report displays resource capacity 
data across resource pools, regions, roles, organization units, and fiscal time 
periods. The resource capacity context enables you to view data from a resource 
pool manager’s perspective.
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Baseline Demand Vs. Active Staffing Profile Demand for a Project

You can create a report that enables you to compare active staffing profiles 
with baseline staffing profiles for specific projects. Table 2-7 lists the RM 
Universe objects that you to add to a Web intelligence document to create this 
report.

Table 2-7. RM Universe objects for a report used to compare the baseline 
demand and active staffing profile demand for a project

Object Class Result Objects Query Filters / 
Prompt Selection Mode

Project Information Project Name Project Name

Staffing Profiles Staffing Profile Name
Baseline Staffing Profile

Staffing Profile Name

Staffing Profiles > 
Positions 
(subclass)

Position Name

Fiscal Periods Quarter Period Name
Date Range / Begin Period, 
End Period, Time Granularity

Resource Demand 
> Demand (FTE)

Committed Demand (FTE)

Softbooked Demand (FTE)

Unmet Demand (FTE)

All Demand (FTE)
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Set the query filters as shown in Figure 2-1.

Figure 2-1. Query filters for the ad hoc report Baseline Demand Vs. Active 
Staffing Profile Demand for a Project

Creating an Ad Hoc Report on HP Resource Management Data: Example 
on page 28 provides an example of how to add these objects to the Web 
Intelligence document in InfoView.

If your fiscal year begins in a month other than January, and your report query 
specifies a time granularity of quarters, half years, or years, then make sure that the 
Begin Period month begins on the fiscal quarter, half year, or year, respectively. 
Otherwise invalid results are returned.
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Demand, Capacity, and Actual Effort Report (Grouped by Primary Organizational Unit)

You can create a report that shows demand, capacity, and actual effort data for 
resources grouped by the primary organizational unit to which the resources 
belong. Table 2-8 lists the RM Universe objects to use to create this report. 

For an example of how to add the objects to the Web Intelligence document, 
see the procedure described in Creating an Ad Hoc Report on HP Resource 
Management Data: Example on page 28.

Table 2-8. RM Universe objects for a report used to show that shows demand, 
capacity, and actual effort data for resources grouped by primary 

organizational unit

Object Class Result Objects Query Filters / 
Prompt Selection Mode

Resources Primary Organization Unit Primary Organization Unit

Fiscal Periods Month Period Name Date Range

Resource Pools Resource Pool Name

Staffing Profiles Staffing Profile Name

Exclude Demand from 
Baseline Staffing Profile

Exclude Obsolete Demand 
from Proposal

Roles Role Name

Resource Capacity 
> Capacity (Hours) 
subclass

All Capacity (Hours)

Resource Demand 
> Demand (Hours) 
subclass

All Demand (Hours)

Resource Effort Effort (Hours)

If you select specific primary organization units in the filter condition, unnamed 
capacity data are excluded from the results since unnamed resources do not belong 
to any organization units. If you do not select any specific primary organization units in 
filter condition, the report includes any unnamed capacity.
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Total Demand Vs. Capacity Plus Additional Resource Pool Data

A resource pool manager can create a report that shows a comparison of 
demand and capacity for a resource pool with detailed resource pool 
information. Table 2-9 lists the RM universe objects to use to create this report, 
and where to place them on the New Web Intelligence Document page.

For an example of how to add the objects to the Web Intelligence document, 
see the procedure described in Creating an Ad Hoc Report on HP Resource 
Management Data: Example on page 28. 

Table 2-9. RM Universe objects to include in a report on demand, capacity, and 
actual effort, with data grouped by primary organizational unit

Object Class Result Objects Query Filters / 
Prompt Selection Mode

Resource Pools

Resource Pool Name

Resource Pool Managers

Parent Resource Pool

Parent Resource Pool 
Name1

Resource Pool Name

Fiscal Periods Year Period Name Date Range

Roles Role Name

Resources Resource Name

Resource Capacity 
> Capacity (FTE)

All Capacity (FTE)

Named Capacity (FTE)

Unnamed Capacity (FTE)

Resource Demand 
> Demand (FTE)

All Demand (FTE)

Unmet Demand (FTE)

Committed Demand (FTE)

Softbooked Demand (FTE)
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Resource Pools by Region

You can create a report that enables users to see which resource pools are 
associated with which regions. Table 2-10 lists the RM Derived Universe 
objects to use to create this report, and where to place them on the New Web 
Intelligence Document page.

A resource assigned to a resource pool is only included in this report if the 
resource has capacity data. When you run the query for this report, and 
InfoView prompts you to select a context to use with the query, select the 
“Resource capacity” context.

For an example of how to add the objects to the Web Intelligence document, 
see the procedure described in Creating an Ad Hoc Report on HP Resource 
Management Data: Example on page 28. 

Table 2-10. RM Universe objects to include in a report on
resource pools grouped by region

Object Class Result Objects Query Filters / Prompt 
Selection Mode

Resource Pools
Resource Pool Name

Resource Pool Managers

Regions Region Name
Region Name / Value(s) from 
list

Roles Role Name

If, as in this case, the set of objects you select to construct your ad hoc report query 
can be retrieved through multiple join paths, InfoView prompts you to select a context 
for the query. (A context defines a join path.)
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All Resources by Resource Category

You can create a report that enables you to see the resource pools and 
resources used to staff a project. Table 2-11 lists the RM universe objects to 
use to create this report, and where to place them on the New Web Intelligence 
Document page.

When you run this report query, you are prompted to select a context for the 
report. Select Capacity Context for this report.

For an example of how to create and run an ad hoc report for HP Resource 
Management, see Creating an Ad Hoc Report on HP Resource Management 
Data: Example on page 28.

Table 2-11. RM Universe objects to include in a report on which resources in 
which resource categories are assigned to PPM Center projects

Object Class Result Objects Query Filters / 
Prompt Selection Mode

Resources

Resource Category

Primary Organization Unit

Resource Name

Primary Role

Resource Category / Prompt

Resource Pool 
Name

Resource Pools
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All Assignments to Resource (by Staffing Profile) with Role, Showing All Effort

You can create a report that shows the resources (and roles) assigned to 
staffing profiles, the effort that these resources have logged, and the demand 
that each of the staffing profiles requested of the resources. A resource 
manager or project manager can use this report to compare the actual effort a 
resource has made with what a staffing profile originally requested.

You can tailor this report to show only the actual effort that resources have 
logged. If you do, however, keep in mind that if your query does not contain 
demand information, then the report results exclude resources who have not 
logged time during the time period you specify for the query. This means that 
you cannot see all of the resources assigned to the staffing profile.

Table 2-12. RM Universe objects to include in a report on which resources are 
assigned to which staffing profiles and the effort the resources have logged

Object Class Result Objects Query Filters

Staffing Profiles Staffing Profile Name

Resources
Resource Name

User Name

Resource Demand 
> Demand (Hours)

All Demand
Exclude Obsolete Demand 
from Proposal

Resource Effort Effort (Hours)

Fiscal Periods <Period> Name Date Range

Roles Role Name

Project Information Project Name

Request 
Information

Source Entity Type

Request ID

Actual effort can be associated with the staffing profile level only if time is logged 
against a project or a HP Portfolio Management request (which is associated with 
staffing profiles), but not to the position level. This means that when you perform an 
ad hoc query, you can associate actual effort with staffing profile attributes only, and 
not positions attributes.
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Staffing Profile Details for Resources

You can create a report that displays staffing profile details for resources. This 
report would list resources along with their start and end dates, role requested, 
org unit, resource pool, manager, and the primary role each resource assumes 
in the organization. Table 2-13 lists the RM universe objects to use to create 
this report, and where to place them on the New Web Intelligence Document 
page.

When you run this report query, you are prompted to select a context for the 
report. Select Resource Demand Context for this report.

For information about how to add the objects to a new Web Intelligence 
document, see the procedure described in Creating an Ad Hoc Report on HP 
Resource Management Data: Example on page 28.

Table 2-13. RM Universe objects to include in a report on which resources in 
which resource pools are assigned to a PPM Center project

Object Class Result Objects Query Filters / 
Prompt Selection Mode

Staffing Profiles

Staffing Profile Name

Start Date

Finish Date

Staffing Profile Name / Prompt

Roles Role Name

Resources

Primary Organization Unit

Manager Name

Resource Name

Resource Pools Resource Pool Name
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3 Reporting on HP Time Management
This chapter addresses Operational Reporting for HP Time Management. It 
provides information about the preconfigured Time Sheet Compliance report 
that HP supplies and the ad hoc reports that you can create for your HP Time 
Management data.

Time Sheet Compliance Report

HP provides the Time Sheet Compliance report for HP Time Management 
with the Operational Reporting solution. This report enables you to 
continuously monitor time entry compliance across your entire organization 
and to identify organizational units and resources that are out of compliance. 
You can monitor time compliance company-wide, without having to delve into 
tedious details. Summarized data provide an overview of time compliance 
within the context of management chains, organizational units, or resource 
pools.

The Time Sheet Compliance report displays the total number of time sheets 
logged, submitted (or not), approved on time (or not), as well as trends in 
compliance over specified time periods. If you need additional information, 
you can use drill-down functionality to see the details of time compliance at 
each level of the management chain, organization unit and resource pool.

This section provides information about the required and optional prompts for 
the Time Sheet Compliance report query, and descriptions of the displayed 
report results.
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Time Sheet Compliance Report Query Information

Figure 3-1 shows the Prompt dialog box for the Time Sheet Compliance 
Report. Table 3-1 provides descriptions of the information you provide for the 
query.

Figure 3-1. Prompt dialog box for the Time Sheet Compliance Report

For information about how to create new Web Intelligence report documents to report 
on your HP Time Management data, see Ad Hoc Reports for HP Time Management 
on page 53.
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Table 3-1. Prompts for the Time Sheet Compliance Report query

Prompt
* Value Required Description

Period Range Beginning Date

Determines the start date of the date interval for 
data displayed in the report.

If the end date of a period falls between the period 
range beginning and end dates, then data for that 
the period are included in the report.

Period Range Ending Date

Determines the end date of the date interval for 
data displayed in the report.

If the end date of a period falls between the period 
range beginning and ending dates, then data for 
that the period are included in the report.

Time Sheet Line Status(es)

Determines whether the report displays data for all 
time sheet lines, regardless of line status, or only 
for time sheet lines that have a specific status.

Select one of the following values:

 * (default)

 Unsubmitted

 Submitted

 Approved

 Rejected

 Frozen

 Closed
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Time Sheet Status(es)

Determines whether the report displays data for all 
time sheets, regardless of line status, or only for 
time sheets that have a specific status.

Select one of the following values:

 * (default)

 Unsubmitted

 Pending Approval

 In Rework

 Approved

 Frozen

 Closed

 Missing 

Note: Although “Missing” is not a valid status for 
PPM Center time sheets, in operational reports, it 
represents time sheets that have no assigned 
status.

* Tolerance for Approval 
(days)

Number of days after the period end date after 
which the time sheet cannot be approved as 
compliant.

* Tolerance for Submission 
(days)

Number of days after the period end date after 
which the time sheet cannot be submitted as 
compliant.

* Top Org Unit

Filter report data based on a selected 
organizational unit. The report returns all of the 
data that fall below the organizational unit in the 
hierarchy.

Request Type Name(s)
(Optional) Filters report data based on one or more 
selected request types.

Project Name(s)
(Optional) Filters report data based on one or more 
selected projects.

Location Code(s)
(Optional) Filter report data based on one or more 
selected locations.

Table 3-1. Prompts for the Time Sheet Compliance Report query

Prompt
* Value Required Description
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Resource Category(s)
(Optional) Filter report data based on one or more 
selected resource categories.

Department(s)
(Optional) Filter report data based on one or more 
selected departments.

Company(s)
(Optional) Filter report data based on one or more 
selected companies.

Charge Code(s)
(Optional) Filter report data based on a selected 
charge code.

Table 3-1. Prompts for the Time Sheet Compliance Report query

Prompt
* Value Required Description

The Time Sheet Compliance report includes timesheets for the resource pool to which 
a resource currently belongs. This is true even if the timesheets are for a future or past 
time period and the resource is associated with a different resource pool for that time 
period.
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Time Sheet Compliance Report Results

The following sections provide descriptions of the Time Sheet Compliance 
Report results as they appear on the different report tabs.

Direct Manager Tab

The Direct Manager tab shows submission and approval compliance data 
grouped by manager hierarchy and resource category. The manager hierarchy 
in the report is shown from the top, up to three levels deep. The query used to 
generate the report includes up to ten hierarchy levels. This can be useful in 
data filtering.

Table 3-2 lists descriptions of the columns displayed on the Direct Manager tab 
of the Time Sheet Compliance Report.

If, in the past, you purged time-sheet data from the audit events table in an effort to 
improve performance, that data is no longer available for reporting and is not included 
in the Time Sheet Compliance Report results.

Table 3-2. Columns on the Direct Manager tab of the
Time Sheet Compliance Report

Column Heading Description

Manager Hierarchy - Level 1 Top-level manager in the management hierarchy

Manager Hierarchy - Level 2
Second-level manager from the top in the 
management hierarchy

Manager Hierarchy - Level 3
Third-level manager from the top in the 
management hierarchy

Resource - Direct Manager
Direct manager or the lowest-level manager for 
the resource.

Resource - Category Category to which the resource belongs

Time Sheet Compliance - 
Expected Total Time Sheets

Number of time sheets that must be submitted for 
compliance

Submissions - Total Total number of submitted time sheets

Submissions - Compliant Total number of compliant time sheets submitted
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To see detailed information about a specific resource manager, click the 
hyperlinked name for the manager. The Resource Information Report opens in 
a new web browser window and displays the manager’s name, department, 
location, category, company, role name, and direct manager.

Submissions - % Compliance
Total percentage of submitted time sheets that are 
compliant

Approvals - Total
Total number of submitted time sheets that were 
approved

Approvals - Compliant
Total number of time sheets that were compliant 
for approval

Approvals - % Compliance Approval compliance percentage

Table 3-2. Columns on the Direct Manager tab of the
Time Sheet Compliance Report

Column Heading Description
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Org Unit Tab

The Org Unit tab displays submission and approval compliance data grouped 
based on the org unit hierarchy and the resource category. The org unit 
hierarchy in the report is shown from the top up to three levels deep. The query 
used to generate the report includes up to ten hierarchy levels, which can be 
useful in filtering data.

Table 3-3 lists descriptions of the columns displayed on the Org Unit tab of the 
Time Sheet Compliance Report.

The Org Unit tab shows group totals for the org unit and for three levels of org 
units, starting at the top of the management hierarchy. To see detailed 

Table 3-3. Columns on the Org Unit tab of the Time sheet Compliance Report

Column Heading Description

Org Unit Hierarchy - Level 1 Top org unit in the org unit hierarchy

Org Unit Hierarchy - Level 2
Second org unit from the top of the org unit 
hierarchy

Org Unit Hierarchy - Level 3
Third org unit from the top of the org unit 
hierarchy

Resource - Direct Manager Direct, or lowest-level manager for the resource

Resource - Category Category to which the resource belongs

Time Sheet Compliance - 
Expected Total Time Sheets

Number of time sheets that must be submitted 
for compliance

Submissions - Total Total number of submitted time sheets

Submissions - Compliant 
Total number of submitted time sheets that 
were compliant

Submissions - % Compliance Submission compliance %age

Approvals - Total
Total number of time sheets that were 
approved

Approvals - Compliant
Total number of time sheets that were 
compliant for approval

Approvals - % Compliance Approval compliance %age
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information about a specific org unit, click the hyperlinked name of the org 
unit. The Organization Unit Information Report opens in a new web browser 
window and displays the org unit’s name, department, location, category, and 
the org unit manager’s ID.

Resource Pool Tab

The Resource Pool tab displays submission and approval compliance data 
grouped based on the resource pool hierarchy. The resource pool hierarchy in 
the report is shown from the top to three levels deep. The query used to 
generate the report includes up to ten hierarchy levels, which can be useful in 
filtering data.

Table 3-4 lists descriptions of the columns displayed on the Resource Pool tab 
of the Time Sheet Compliance Report.

Table 3-4. Columns on the Resource Pool tab of the 
Time Sheet Compliance Report

Column Heading Description

Resource Pool Hierarchy - Level 1
Top resource pool in the resource pool 
hierarchy

Resource Pool Hierarchy - Level 2
Second resource pool from the top of the 
resource pool hierarchy

Resource Pool Hierarchy - Level 3
Third resource pool from the top of the 
resource pool hierarchy

Resource - Resource Pool
Resource pool to which the resource 
belongs

Resource - Category Category to which the resource belongs

Time Sheet Compliance - Expected 
Total Time Sheets

Number of time sheets that must be 
submitted for compliance

Submissions - Total Total number of submitted time sheets

Submissions - Compliant 
Total number of submitted time sheets that 
were compliant

Submissions - % Compliance Submission compliance %age
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To see a report that contains additional details about the manager of the 
resource, click the hyperlinked manager name. The Resource Information 
Report opens in a new browser window and displays the manager’s name, 
resource category, location, department, company, direct manager, role and 
email address.

The time sheets for resources who participate in multiple resource pools are 
counted against each resource pool.

Approvals - Total
Total number of time sheets that were 
approved

Approvals - Compliant
Total number of time sheets that were 
compliant for approval

Approvals - % Compliance Approval compliance %age

Table 3-4. Columns on the Resource Pool tab of the 
Time Sheet Compliance Report

Column Heading Description

The Time Sheet Compliance report includes time sheets for the resource pool to 
which a resource currently belongs. This is true even if the time sheets are for a future 
or past time period and the resource is associated with a different resource pool for 
that time period. As a result, the Time Sheet Compliance Report may exclude some 
resource pools. For example, if a resource was assigned to a different resource pool 
in the past, that resource pool is not included in the Time Sheet Compliance Report.
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Ad Hoc Reports for HP Time Management

The following sections provide information about the operational reports that 
you can create for HP Time Management, and includes examples on how to 
create a few of these reports. These sections also provides information about 
the contexts available for the reports, and includes guidance on how to use 
PPM Center universe objects in operational report queries.

Contexts for Ad Hoc Reports for HP Time Management

When you create an ad hoc report for HP Resource Management, InfoView 
may prompt you to select a context for your report query. A context consists of 
a set of well-defined joins that create a unique query path involving multiple 
dimensions and facts.

If the multiple facts and measures in a reporting universe are related to a 
common set of dimensions, the joins between multiple facts and the related 
dimensions result in a loop. By providing separate contexts for each fact and 
the related dimensions, the loop is eliminated, so that you can query multiple 
facts across a set of common dimensions.

Operational Reporting provides the following contexts for the ad hoc reports 
you create for HP Time Management data:

 Time Sheet Compliance context

The “Time Sheet Compliance” context enables you to query for 
compliance measures such as Required Time Sheets, Compliant 
Submissions, Compliant Approvals, Total Submissions, Total Approvals, 
Submission Percent, and Approval Percent. In this context, the resource 
pool is joined through the resource table for compliance measures.

The resource pool is joined through the resource table for compliance measures 
because no actuals exist for missing time sheets. To get the right compliance 
measures for the resource pools, the join with resource table is used.
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 Time Sheet Actuals context

The Time Sheet Actuals context enables you to query actuals measures 
such as Total Effort and Total Cost. In this context, the resource pool is 
directly joined with the actuals fact table for the Time Sheet actuals.
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Best Practices for Reporting on HP Time Management Data

This section provides recommendations for getting the best results in the ad 
hoc operational reports you create for your HP Time Management data.

Reporting on Multiple Work Item Types

If you generate a report that includes a work item type object (such as Project, 
Request, or Miscellaneous object) from the Time Sheet Lines class, the report 
results includes only the numbers for that specific work item type. If you 
generate a report that includes more than one specific work item type object, 
no data are returned. For example, if you create and run a report that contains 
both the Project object and the Request object, no data are returned because no 
time-sheet line logs time against both types of work items. To see the results 
for different work item types, you must use the Work Item Type and Work 
Item Type Name objects instead of the individual objects such as Project, 
Request, or Miscellaneous.

Avoiding Inaccurate Data Display Resulting from Summing of Measures

Measures in TM Derived Universe are defined at a time-sheet level. This 
means that if you create a report that shows data from the time-sheet line level, 
and you then remove the time-sheet line attributes from the report display (but 
not from the report query), the BusinessObjects sums (collapses) the measures.

The summing of measures results in inaccurate reports and the data displayed 
are different than the data specified in the query. In such cases, when you build 
the report, remove attributes that are not needed for the display from the 
column selections so that the query does not use them.
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Reporting on Compliance Measures

You cannot report on the compliance measures for fiscal periods. Compliance 
measures are only supported with HP Time Management periods.

Roles and Regions

Neither roles nor regions are supported for any measures in
HP Time Management.

Aggregate Values and Percentages

Because percentages cannot be aggregated, the aggregation function is not 
applied to the Submission Percent and Approval Percent measures. If you 
include the Submission Percent and Approval Percent objects in a query, 
BusinessObjects does not aggregate the values at higher levels in the report. 
For example, if you query for Organization, Manager, and Submission Percent, 
you do not see the aggregate compliance percentage at the organization level. 
If you want to see aggregate values at different levels, you must use the 
Compliant Submissions and Required Timesheets objects and compute the 
percentage in the report. (See the HP-supplied Time Sheet Compliance report 
for this usage.)

Using Filters to Limit Report Output

Because BusinessObjects analyzes only a fixed number of rows (the default is 
5000), make sure that you including appropriate filters to limit report output.

Comparing the Role of a Position and the Role of a Resource Assigned to the Position

In creating a query that compares the role of a position with the actual role of a 
resource assigned to that position, you must do the following:

 Select the Role Name object (Roles class) for the role of the position

 Select the Primary Role object (Resources class) for the role of the 
resource

 Select either the “Resource Demand from Staffing Pool Region” context or 
the “Resource Demand on Resource Pool Region” context.
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Querying Against Large Datasets

By default, queries time out after running for ten minutes. If you have selected 
query filters that retrieve a large volume of data, your query may time out and 
fail to return report results. To prevent this from occurring, do one or both of 
the following:

 Modify the universe parameters (on the Controls tab of the Universe 
Parameters dialog box) to increase the execution time limit.

 Modify the query filters to retrieve a smaller dataset.
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Creating Ad Hoc Reports for HP Time Management

The TM Derived Universe delivered with PPM Center includes classes and 
objects that enable you to create your own operational reports for HP Time 
Management data. The following are just some of the ad hoc reports that you 
can create for your HP Time Management data:

 Delinquent Time Sheets

 Trends in Late Time-Sheet Submission

 Trends in Time-Sheet Processing

 Tracking Billable Time Logged for a Project

 Resources’ Work in Progress

Example Ad Hoc Report for HP Time Management Data

This section provides detailed instructions for creating a query for a report on 
HP Time Management data.

Delinquent Time Sheets

A product manager who needs to know who is not submitting their time sheets 
can create a report that enables her to see which resources, working for which 
project managers, have not submitted a time sheet for a given time period. This 
simple, tabular report shows the number of late submissions by period, for a 
given time range. Data are grouped based on the name of the manager for the 
resources.

If, in the past, you purged time-sheet data from the audit events table in an effort to 
improve performance, that data is no longer available for reporting and is not included 
in the ad hoc reports for HP Time Management data.

The following example includes very basic steps required to create and run this report 
query. For detailed information about creating Web Intelligence documents, see your 
SAP documentation.
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To create a report that shows which resources have not yet logged a time sheet 
for the current period:

1. Open a web browser window and log on to InfoView.

2. In the Navigate section of the InfoView home page, click Document List.

3. From the New list, select Web Intelligence Document.

InfoView displays a list of available universes.

4. Select the TM Derived Universe.

The Data tab in the left pane lists all of the available classes and objects in 
the TM Derived Universe.

The folders and objects visible in the document list depend on the account you 
logged on to, the rights that your BusinessObjects Enterprise administrator 
granted to you, and the settings that you and your administrator enable.
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5. Expand the Resources class folder.

6. Drag the Resource Name object from the Resources class folder to the 
Result Objects panel on the right (top).

7. Drag the Manager Name object from the Resources class folder to the 
Query Filters panel on the right (bottom).
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8. In the Query Filters panel, click the list button in the Manager Name box 
(right end), and select Prompt from the list.

9. On the Data tab (left panel), expand the Time Sheets class folder.

10. Drag the Time Sheet Status object from the Time Sheet class folder to the 
Query Filters panel.

11. In the Time Sheet Status box in the Query Filters panel, click the list button, 
and then select Prompt.

12. On the Data tab, expand the Time Management Periods folder.

13. Drag the Time Management Period Name object from the Time Management 

Periods class folder to the Result Objects panel.

14. Drag the Period Date Range object from the Time Management Periods 
class folder to the Result Objects panel.

15. At the top right of the New Web Intelligence Document page, click Run 

Query.
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The Prompts dialog box opens.

16. To specify the date range for the report:

a. Click Enter Period range Beginning Date, and then use the Select a 

custom date multiselect control to select the beginning date for report 
data.

b. Click Enter Period range Ending Date, and then use the Select a custom 

date multiselect control to select the end date for report data.

17. To select the names of one or more managers:

a. Click Enter value(s) for Manager Name.

b. In the Manager Name list, select the name of one or more managers, and 
then click the right-pointing arrow to add the selection to the box on the 
right.

18. Click Enter value(s) for Time Sheet Status, and then from the list of time 
sheet statuses, select the following values:

 Unsubmitted

 In Rework
62 Chapter 3



19. At the bottom of the Prompts dialog box, click Run Query.

InfoView runs the report, which lists the resource names and the period 
names for which the resources have not submitted time sheets.

20. On the report results page, double-click Report Title, type a name for the 
report in the now enabled text box, and then press enter.

21. On the toolbar, click Save .

22. Name and save the document.
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Additional Ad Hoc Reports for HP Time Management Data

The following sections describe additional queries that you can construct to 
create operational reports for HP Time Management.

Trends in Late Time-Sheet Submission

You can create a report that enables you to uncover trends in late time-sheet 
submissions based on who manages the resources, and the teams, 
organizational units, or departments to which the resources belong. Table 3-5 
lists the TM Derived Universe objects that you would use to create a report on 
trends in late time-sheet submission. 

For an example of how to add objects to a new Web Intelligence document, see 
Example Ad Hoc Report for HP Time Management Data on page 58.

After you create the Web Intelligence document, run the report and then verify 
the results. You can augment this report with additional information such as 
actuals and time periods data. You can also experiment with different ways of 
displaying results by grouping data based on resource name, department, 
manager, or organization units. Once the report contains all of the data you 
want and is organized the way you want it, you can save the report in Excel or 
PDF format.

Table 3-5. TM Derived Universe objects to include in a report on trends in late 
time-sheet submission

Object Class Result Objects Query Filters / 
Prompt Selection Mode

Time Management 
Measures

Compliant Submission

Submission Percent

Total Submissions

Resources 
Dimension

User Name

Manager Name

Primary Org Unit

Department

Manager Name / equal to

Primary Org Units / equal to

Department / equal to

Periods Period Date Range Period Date Range
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Trends in Time-Sheet Processing

If you are a PPM Center project manager responsible for HP Time 
Management, you can create a report that enables you to detect trends in 
time-sheet processing. You can configure this report to show differences 
between the following:

 Time-sheet submissions and time-sheet approval, based on group.

 End of the reporting period and time-sheet approval, based on group.

 Time-sheet rework and time-sheet approval, based on group.

 End of the reporting period and close of the reporting period, based on 
group.

You can also create a report on time-sheet rejection rate that shows the number 
of time sheets rejected (time sheets that required re-work), the resources whose 
time sheets were rejected multiple times, and so on, based on group.

For an example of how to add TM Derived Universe objects to a new Web 
Intelligence document, see Example Ad Hoc Report for HP Time Management 
Data on page 58.
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Tracking Billable Time Logged for a Project

If you are a project manager concerned who needs to monitor the billable time 
your consultants log, you can create a report that shows billable time logged 
for a project during a given period, and includes activity codes and charge 
codes.Table 3-6 lists the TM Derived Universe objects that you would use to 
create a report on billable time for a project. 

The resulting report shows all of the work items for which your resources have 
logged time and actual effort.

For an example of how to add TM Derived Universe objects to a new Web 
Intelligence document, see Example Ad Hoc Report for HP Time Management 
Data on page 58.

Table 3-6. TM Derived Universe objects to include in a report on billable time

Object Class Result Objects Query Filters / 
Prompt Selection Mode

Time Sheet Lines
Work Item Name

Work Item Set Name

Resources
User Name

Manager Name
Manager Name / Equal to

Time Management 
Periods

Time Management Period 
Name

Which Period Date Range?

Time Sheet 
Actuals

Total Effort (Hrs)
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Resources’ Work in Progress

If you are a resources manager who needs to know what each of your direct 
reports is working on, you can create a report that shows you what your 
resources have been involved in (projects, requests, vacation, and so on) over a 
specified time period. Table 3-7 lists the TM Derived Universe objects that 
you would use to create a report on resources’ work in progress.

The resulting report displays all work items for which your resources have 
logged time and actual effort. You can include additional information such as 
request types, packages and so on, in your report query.

Table 3-7. TM Derived Universe objects to include in a report on resources’ work 
in progress

Object Class Result Objects Query Filters / 
Prompt Selection Mode

Time Sheet Lines
Work Item Name

Work Item Set Name

Resources
User Name

Manager Name
Manager Name / Equal to

Time Management 
Periods

Time Management Period 
Name

Which Period Date Range?

Time Sheet 
Actuals

 Total Effort (Hrs)
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4 Reporting on HP Financial Management
This chapter addresses Operational Reporting for HP Resource Management. 
It provides information about the preconfigured Financial Summary report, 
which HP supplies, and some of the many ad hoc reports that you can create 
for your HP Financial Management data.

Financial Summary Report

You can use the Financial Summary report that HP supplies with Operational 
Reporting to monitor ongoing efforts and to generate information that you can 
use for financial forecasting. PPM Center provides portfolio scenarios that can 
help Finance Managers project future scenarios that can be directly compared 
against each other and the ongoing efforts using the Financial Management 
report.

The HP PPM Financial Summary Report enables you to view a comparison of 
the planned values with the actual values for a budget, along with all of the 
budget-related attributes. You can group budget information based on region, 
business objective, or budget type (the entity for which the budget was 
created).

Budget values can be analyzed based on expense type or labor type. Budgets 
costs can be viewed in the defined local currency of the PPM Center system or 
any other currency based on the filter criteria.
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Financial Summary Report Prompts

Table 4-1 lists the prompts for the Financial Summary Report.

Table 4-1. Information to provide for the Financial Summary Report

Prompt
* Required Description

Report Begin Period
From the list of all fiscal periods configured for 
PPM Center, select the starting period for data to 
include in the report.

*Report End Period
From the list of all fiscal periods configured for 
PPM Center, select the end period for data to 
include in the report.

*Time Granularity

Determines the time interval for data displayed in 
the report. Select one of the following values:

 Year displays time periods as yyyy

 Half Year displays time periods as 
h1 or h2/yyyy

 Quarter displays time periods as quarter/yyyy

 Month displays time periods as mm/yyyy

 Week displays time periods as 
mm/dd/yyyy 

*Multiply Factor

From the listed factors, select one of the following:

 1

 1,000

 1,000,000

*Primary Group By

Determines the primary grouping for data in the 
report. Select one of the following values:

 Region

 Financial Summary Type

 Business Unit

 Business Objective
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*Secondary Group By

Determines the secondary grouping category for 
data in the report. Select one of the following 
values:

 Expense Type

 Labor Type

*Select Currency Base

From the list, select one of the following to 
determine base the currency associated with 
financial summary on the default currency for 
PPM Center (base) or the local currency.

 Base

 Local

Enter value(s) for Financial 
Summary Name

To specify financial summaries to include in the 
report, select the names from the list of financial 
summaries in HP Financial Management.

Enter value(s) for Business Unit
To specify business units to include in the report, 
select the names from the list of business units 
configured for HP Financial Management.

Enter value(s) for Financial 
Summary Type

To specify financial summary types to include in 
the report, select one or more of the following 
from the list of financial summary types:

 Project

 Proposal

 Asset

 Org_Unit

 Program

Enter value(s) for Business 
Objective Name 

To specify business objectives to include in the 
report, select the names from the list of business 
objectives in HP Financial Management.

Enter value(s) for Region Name
To specify regions to include in the report, select 
the names from the list of regions configured in 
PPM Center.

Table 4-1. Information to provide for the Financial Summary Report

Prompt
* Required Description
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Ad Hoc Reports for HP Financial Management

The FM Derived Universe delivered with PPM Center includes classes and 
objects that you can use to create your own operational reports for HP 
Financial Management data. This section provides information about the 
contexts available for ad hoc reports on HP Financial Management, the best 
practices for creating reports on HP Financial Management data, and a 
description one of the many possible ad hoc reports that you can create for HP 
Financial Management.

Contexts for Ad Hoc Reports for HP Financial Management

When you create an ad hoc report for HP Resource Management, InfoView 
may prompt you to select a context for your report query. A context consists of 
a set of well-defined joins that create a unique query path involving multiple 
dimensions and facts.

If the multiple facts and measures in a reporting universe are related to a 
common set of dimensions, the joins between multiple facts and the related 
dimensions result in a loop. By providing separate contexts for each fact and 
the related dimensions, the loop is eliminated, so that you can query multiple 
facts across a set of common dimensions.

Operational Reporting provides the following contexts for the ad hoc reports 
you create for HP Financial Management data:

 FA for Programs context

Use the “FA for Programs” context to create queries that include forecast 
and actuals data for programs. This context includes forecast and actuals 
only for proposals and projects. (Assets are not included.)

The forecast and actuals data for programs is stored at a monthly 
granularity. If you select the FA for Programs context, make sure that you 
select the “Date range” or “Yearly Date Range” filter to query data for a 
given time period.
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 Approved for Programs context

The “Approved for Programs” context enables you to create report queries 
that include forecast cost, actual cost, and approved costs for programs. 
Approved costs for proposals, projects, assets and org units are not 
included.

The forecast cost, actual cost, and approved costs data for programs is 
stored at a yearly granularity. If you select the Approved for Programs 
context, make sure that you select the “Yearly Date Range” filter to query 
data for a given time period.

 FA for Proposal/Project/Asset context 

The “FA for Proposal/Project/Asset” context enables you to create report 
queries that include forecast and actuals for proposals, projects, and assets. 
Forecast and actuals data for programs and org units are not included.

The forecast and actuals data for proposals, projects, and assets are stored 
at a monthly granularity. If you select the FA for Proposal/Project/Asset 
context, make sure that you select the “Date range” or “Yearly Date 
Range” filter to query data for a given time period.

 Approved for Proposal/Project/Asset context 

The “Approved for Proposal/Project/Asset” context enables you to create 
report queries that include approved costs data for proposals, projects, and 
assets. Approved costs data for programs and org units are not included.

The approved costs data for proposals, projects, and assets is stored at a 
yearly granularity. If you select the Approved for Proposal/Project/Asset 
context, make sure that you select the “Yearly Date Range” filter to query 
data for a given time period.
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 Approved for Org Units context 

The “Approved for Org Units” context enables you to create report queries 
that include cost, actual cost, and approved costs data for org units. 
Approved cost data for programs, proposals, projects, and assets are not 
included.

The cost, actual cost, and approved costs data for org units are stored at a 
yearly granularity. If you select the Approved for Org Units context, make 
sure that you select the “Yearly Date Range” filter to query data for a given 
time period.
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Best Practices for Reporting on HP Financial Management Data

This section provides recommendations for getting the best results in the ad 
hoc operational reports you create for your HP Financial Management data.

Grouping Program Measures by Business Objective When the Program has Multiple 
Business Objectives

Suppose you want to construct an ad hoc report query that includes program 
measures (Forecast, Actuals, Approved, and so on) grouped by business 
objective, and you want the query results to include one or more objects from 
the Business Objectives class (in the FM Derived Universe). If you are 
reporting on a program that has multiple business objectives, the resulting data 
for the measures are multiplied by the number of associated business 
objectives. This produces incorrect report data.

To work around this issue, create a report variable that counts the number of 
separate business objectives for the program. Use this variable in each ad hoc 
report cell that displays the program measure, to divide the cell’s total by this 
value. (The Financial Summary report uses this mechanism.)

Querying Against Large Datasets

By default, queries time out after running for ten minutes. If you have selected 
query filters that retrieve a large volume of data, your query may time out and 
fail to return report results. To prevent this from occurring, do one or both of 
the following:

 Modify the universe parameters (on the Controls tab of the Universe 
Parameters dialog box) to increase the execution time limit.

 Modify the query filters to retrieve a smaller dataset.

Selecting Yearly Granularity for the Financial Summary Report

If you run the Financial Summary Report with Year as the selected time 
granularity, you must specify the starting month of the fiscal year as the Begin 
Period, and the ending month of the fiscal year as the End Period. Otherwise, 
the yearly values for Forecast and Actuals measures are incorrect.
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Disabling Financial Summary for a Program

In HP Program Management, you can disable the financial summary 
associated with a program. (For details, see the HP Program Management 
User’s Guide.) During the regular incremental updates of HP Financial 
Management data, financial summary data for programs are brought over to 
the reporting database. The Financial Summary report results do not include 
the financial summary data, but ad hoc reports results for HP Financial 
Management do include this data.

To filter out programs with the financial summary disabled, do one of the 
following as you create the report query in InfoView:

 Add the Financial Summary: Enabled filter (FM Derived Universe, 
Financial Summary class) to the Query Filters panel.

Alternatively,

1. Add the Financial Summary Enabled object (FM Derived Universe, 
Financial Summary class) to the Query Filters panel.

2. In the Query Filters panel, click the list button in the Financial Summary 

Enabled box (right end), and select Prompt from the list.

3. When you run the report and are prompted for a value for Financial 
Summary Enabled, enter Y.

Comparing the Role of a Position and the Role of a Resource Assigned to the Position

In creating a query that compares the role of a position with the actual role of a 
resource assigned to that position, you must do the following:

 Select the Role Name object (Roles class) for the role of the position

 Select the Primary Role object (Resource class) for the role of the resource

 Select either the “Resource Demand from Staffing Pool Region” context or 
the “Resource Demand on Resource Pool Region” context.
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Creating an Ad Hoc Report for HP Financial Management: 
Assets, Proposals, and Projects by Program

If you are a program manager, you can create a report that shows all of the 
assets, proposals, and projects associated with your programs. Table 4-2 lists 
the FM universe objects to use to create this report, and where to place them on 
the New Web Intelligence Document page.

Table 4-2. FM Universe objects to include in a report on assets, proposals, and 
projects as a function of program

Object Class Result Objects
Query Filters / 
Prompt Selection 
Mode

Proposals, Projects and 
Assets (Lifecycle Entities)

Parent Program Name

Financial Summary Name

Source Entity Type

Request ID

Request Status

Request Type Name

Active Workflow Step Name

Application

Business Objective Name

Business Unit

Department

Entity Asset Class

Entity Project Class

Entity Region

Priority

Source Entity Health

Source Entity Name

Workflow Name

Parent Program Name
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Fiscal Periods Year Period Name Date Range

Financial Summary > 
Approved Budget

Approved Base

Financial Summary > 
Forecast & Actuals > Costs

Forecast Base

Actual Base

Table 4-2. FM Universe objects to include in a report on assets, proposals, and 
projects as a function of program

Object Class Result Objects
Query Filters / 
Prompt Selection 
Mode
78 Chapter 4



5 Adding Customized PPM Center Data 
Fields to Ad Hoc Operational Reports
About this Chapter

This chapter provides information about how to add the customized user data 
fields that exist in your PPM Center forms to operational reports. It also 
provides information on how to save and share the reports your create in 
InfoView.

Adding User Data Fields to Operational Reports

This chapter provides information about how add the customized user data 
fields that exist in your PPM Center forms to operational reports. It also 
provides information on how to save and share the reports your create in 
InfoView.

To accomplish this, you first edit a universe user data object to represent a user 
data field in PPM Center, and then add the user data field to an ad hoc report 
(in InfoView). The following sections provide instructions for these tasks.

For information about the user data objects in the PPM Center universes, see the 
Data Model Guide.
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Editing a User Data Object to Represent a User Data Field

To edit a user data object to represent a user data field that exists in 
PPM Center:

1. Log on to Universe Designer and open the universe associated with the 
PPM Center module that you are reporting on.

2. In the Universe panel (left panel), navigate to the subclass that contains 
user-configured data objects for the PPM Center entity for which user data 
fields are defined.

3. Double-click the Visible User Data object that corresponds to the user data 
field in PPM Center. For example, if a user data field is defined for 
requests in PPM Center, and that field has the user data qualifier USER_
DATA3, then, in the Universe designer Universe pane, you would navigate 
to the Request User Configured Data subclass, and then double-click 
Visible User Data3.

The Edit Properties of Visible User Data<N> dialog box opens to the 
Definition tab.

4. In the Name box, replace the existing value with the name of the user data 
field defined in PPM Center. 

5. Click OK, and then save the file.

6. Repeat step 2 through step 4 for each additional user data field that you 
want to include in your operational reports.

7. Save the modified universe to the BusinessObjects repository, as follows:

a. Click File > Export.

The Export Universe dialog box opens.

b. To export the universe to a folder other than the one displayed in the 
Domain box, click Browse, and then locate and select a different 
domain.
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c. In the Group box, select the group or groups that require access to the 
exported universe. (In the Universes list, the modified universe is 
selected by default.)

Universe Designer displays a message that confirms the export 
operation.

Users can now access the modified universe objects in InfoView.

8. Log on to InfoView and open the Web Intelligence report document to 
which you want to add the user data field(s).

9. In the Prompts dialog box, select values for any required prompts, and then 
click Run Query.

10. In the InfoView toolbar, click Edit.

11. In the Web Intelligence toolbar, click Edit Query.

The Data tab in the Universe pane now lists all of the objects in the 
universe that you modified and exported. 

a. To add the user-configured object for the user data field as a report 
query filter and set the prompt properties:

b. On the Data tab, select the object, and then drag and drop it into the 
Query Filters section (on the right) where you want it to be listed in the 
Prompts dialog box relative to the other prompts.

c. To change the query operator for the prompt, select an operator from 
the list of operators.

d. On the prompt object in the Query Filters section, click Prompt 

properties.

The Prompt dialog box opens.

e. Set the properties for the prompt, and then click OK.

12. On the report results page, drag the fields to where they make sense in the 
report.
Adding Customized PPM Center Data Fields to Ad Hoc Operational Reports 81



Editing an Ad Hoc Report to Include a User Data Field

To edit an ad hoc report to include a user data field:

1. Log on to InfoView and open the Web Intelligence document for the 
report.

2. Add a new filter for a staffing profile line user data field, and incorporate 
into report queries.

3. Add a new display column and for a staffing profile line user data field, and 
incorporate into the report.

4. Add a new grouping mechanism for a staffing profile line user data field, 
and incorporate into the report.

5. Add a new filter for a resource pool user data field, and incorporate into 
report queries.

6. Add a new display column and for a resource pool user data field, and 
incorporate into the report.

7. Add a new grouping mechanism for a resource pool user data field, and 
incorporate into the report.

8. Run the report query.
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Saving and Sharing Operational Reports

If your report viewers use InfoView, you can save your operational reports as 
public documents and send them directly to stakeholders. You can also 
schedule documents for automated refresh and distribution at a time and date 
you specify. To share reports with viewers who do not use InfoView, you can 
send reports as Microsoft Excel, PDF and Web Intelligence documents as 
email attachments that recipients can view and print. You can save a report 
(Web Intelligence document) in InfoView as a file in any of the following 
formats:

 Excel spreadsheet

 PDF file

 CSV (comma-separated-value) file

To save the results of a report to your computer as an Excel spreadsheet or 
PDF file:

 Select Document > Save report to my computer as, and then select Excel or 
PDF.
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Limitation on Saving a Report as an Excel Spreadsheet

BusinessObjects uses its own internal libraries to generate Excel documents. 
(The version of Excel that you have installed locally is irrelevant.) These 
internal libraries create a document with the same row and column limitations 
as Excel 2003. Regardless of which version of Excel you use to view the 
exported report results, data are missing.

Workaround

To work around the limitation imposed on exporting report results to an Excel 
spreadsheet, save the report in .txt format, and then import the text document 
into Excel 2007. Note that, although the resulting data are complete, formatting 
is lost.
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